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 Introduction  ¶  1 

INTRODUCTION 

WELCOMEé 

é to Sanako Study 700, a software language learning 
solution that combines the use of multimedia with a suite of 
essential classroom management tools. Study 700 helps 
teachers deliver effective instruction in any subject area. 

Since it is a pure software solution, Study 700 does not 
require any additional hardware and is therefore easy to 
install and maintain. 

WHAT CAN YOU DO WITH STUDY 700 

Study 700 allows teachers to use their digital learning 
resources to help manage student activity in a stimulating 
interactive environment. The software makes it easy for 
teachers to launch applications and assignments for 
students, upload session files for guided learning activities, 
monitor student screens for support and collaboration, and 
even focus use of the Internet for managed web-based 
learning activities. Communication resources such as live 
two-way audio and text messaging also make it easy for 
teachers to provide individual support for students in need. 
They can also be used to create another layer of interactive 
language-based activities.  

The basic platform of the Study 700 system can be easily 
upgraded and enhanced with separate extension modules, 
making it a flexible solution that can be modified to suit your 
specific teaching needs. 
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GETTING STARTED 

STUDY 700 SYSTEM COMPONENTS 

STUDY 700 TUTOR 

Teachers use the Study 700 Tutor application, which is the 
main interface to the Study 700 system. The Tutor 
application allows teachers to instruct with the Study 700 
system and to control the classroom computers. 

STUDY 700 STUDENT 

The Study 700 Student application is installed onto all 
student computers. Study 700 Student connects to Study 
Server at system startup and runs in the background 
listening for commands from Study 700 Tutor.  

Students can open the student interface to work 
independently, however, teachers are able to control student 
computers, regardless of whether the Student application is 
visible on student screens. 

STUDY SERVER 

Study Server application is the information center of the 
Sanako Study 700 system and both the Tutor and Student 
components automatically connect to it. All system data is 
passed through the Server and it allows communication 
between the Tutor and Student components. 

EXTENSION MODULES FOR STUDY 700 

The functionality of the Study 700 system can be extended to 
suit more specific needs and tasks with additional modules. 
The available extension modules for Study 700 include:  

¶ Sanako Study Examination Module 
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¶ Sanako Study Pronunciation Activity Module 

¶ Sanako Study Video Live Module 

¶ Sanako Admin Tool 

¶ AP- Exam for Study 700 

¶ Content Exercise for Study 700 

¶ Listening Comprehension for Study 700  

¶ Model Imitation for Study 700  

¶ Reading Practice for Study 700  

¶ Round Table Discussion for Study 700  

¶ Telephone for Study 700 

¶ Vocabulary Test for Study 700  

¶ Text-to-Speech for Study 700  

¶ MP3 Encoding for Study 700  

You can find descriptions and more information on each 
extension module in the Extension modules for Sanako 
Study 700 section at the end of this User Guide. 
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STUDY 700 TEACHER 
APPLICATION 

OVERVIEW 

SESSIONS & ACTIVITIES 

Sessions and activities are two key concepts that form the 
basis of teaching with the Study 700 application 

SESSIONS 

In Study 700, students can be divided into six different 
sessions that can be controlled separately and that can 
simultaneously perform different activities. 

ACTIVITIES 

Teaching in the Study 700 environment is based on a set of 
preset learning activities, which can be utilized in the basic 
teaching of any subject. You can set different activities for 
different sessions.  

The Study 700 program includes the following activities: 

¶ Self-Access 

¶ Discussion 

¶ Tutoring 

¶ Web Browsing 
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COMPONENTS OF THE TUTOR INTERFACE 

 

MENUS 

 

The three menus (File, Tools and Help) give you access to 
settings and preferences, to your license information, and to 
online help. 

CLASSROOM VIEW 

 

You can edit the classroom view by adding and removing 
student workstations and by arranging them to match your 
physical classroom environment. Student icons are color-
coded according to the sessions they are in. 

Menus 

Classroom view 

Sessions 

Function buttons 

Activity 
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SESSIONS 

 

Study 700 has six different sessions that students can be 
placed into. The sessions allow you to divide your class into 
smaller groups that can be engaged in different learning 
activities. Empty sessions are grayed. 

FUNCTION BUTTONS 

The functions in the function buttons can be used for the 
currently selected session or for the entire class. 

¶  Clicking the button itself will perform the function for 
the entire class. 
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¶  Clicking the icons will perform the function for the 
current session. 

 

For more information on the different function buttons, see 
Functions for entire class / a session later in this guide. 

FUNCTIONS FOR A SINGLE STUDENT 

To use the different functions for a single student, click on 
the student icon. This opens a student monitoring window 
with functions that apply to the selected student. 

 

For more information on the different functions in the 
monitoring window, see Functions for a single student later in 
this guide. 
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ACTIVITY VIEW 

 

The activity view is where you can select and control the 
activity of the current session. 

COMMUNICATION 

To discuss with a single student, click a student icon and 
select Discuss.  

To talk to a session, select a session and in the Function 
Buttons click the icon next to the Talk button. 

 

To talk to the entire class, click on Talk in the Function 
Buttons. 
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For more information on the different functions in the 
monitoring window, see Functions for a single student later in 
this guide. 

FUNCTIONS FOR ENTIRE CLASS / A SESSION 

¶  Clicking the button itself will perform the function for 
the entire class. 

 

For the entire 

class 
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¶  Clicking the icons will perform the function for the 
current session. 

 

For more information on the different function buttons, see 
Functions for entire class / a session later in this guide. 

For the current 

session 
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GETTING STARTED 

STARTING STUDY 700 TUTOR 

After the installation, you are ready to start Study 700. To 
start Study 700 Tutor, open the Windows Start menu (lower 
left corner on your screen) and select Programs ï Sanako ï 
Study 700 ï Tutor. 

SELECTING TUTOR NAME AND CLASS 

Before the Tutor application opens, you need to select your 
tutor name and the class that you are teaching. If you are not 
teaching a specific class, you can select the template class 
or an empty class and then manually pick the students you 
want to include in the class. 

 

For information on adding students to the classroom, see the 
Adding students into the classroom section below. 

For information on setting tutor names and classes, see the 
Sanako Study Technical Guide. 

STARTING STUDY 700 STUDENT 

To open the Study 700 Student interface, click the Windows 
Start menu and select Programs ï Sanako ï Study 
Student ï Student. The teacher can also at any time display 
the Student applications on student workstations by clicking 
the PC Control button on the Tutor interface and selecting 
Show student application. 

Even if the Study 700 Student application is not open on the 
student screen, it is always running in the background 
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listening to commands from Study 700 Tutor when the 
student workstation is on. 

ADDING STUDENTS INTO THE CLASSROOM 

To add students into the classroom, click the Show Corridor 
text at the bottom of the Tutor interface.  

 

This opens a window that displays all the currently running 
student workstations. Select the workstations that you want 
to add and then click the Add to session A button. 

 

MOVING AND ARRANGING THE STUDENT ICONS 

To move and arrange the student icons on the classroom 
view, open the Tools menu, select Admin and then Move 
and align student icons. This opens a control bar with 
functions for arranging the classroom layout.  

EDITING STUDENT NAMES AND NUMBERS 

To edit the student names and numbers, right-click on a 
student icon and select Edit and then either Name or 
Position.  

You can also let the students enter a name for themselves. 
To do this open the Tools menu and select Ask student 
names. 
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REMOVING STUDENTS 

To move a student from the class back to the corridor, right-
click a student icon and select Send to corridor. The 
student can then be selected to another class by another 
teacher. 

To remove a student and the student icon from the class 
view, right-click a student icon and select Exclude from 
class (and layout). Once the student icon is removed, the 
classroom configuration can be saved as a new class. 

ATTENDANCE REPORT 

If you want to keep a digital record of studentsô attendance, 
you can view and save an attendance report of the current 
class. Open the File menu, select Create Attendance 
Report and then select where to save the attendance file.  

 

GETTING HELP 

If you are unsure of some of the functions in the applications, 
you can access the Study 700 online Help file and view video 
tutorials in either the Teacher or Student application by 
opening the Help menu and selecting Help or Video 
Tutorials. 

ENDING A LESSON 

To end the current lesson and close Study 700 Tutor, open 
the File menu and select Exit or click the óXô button in the top 
right corner of the teacher application. 

RESTARTING THE TUTOR APPLICATION 

To restart the tutor application, open the File menu, select 
Restart and then either the Restart option to start again with 
the same tutor and classroom, or the Restart and select 
Tutor option to start again with a different tutor and 
classroom. 
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GROUPING STUDENTS INTO SESSIONS 

You can place students into six different sessions (A-F). 
Empty sessions are grayed. 

 

There are three ways to select students for a session: 

¶ Click Add and then the student icon you want to add. 

¶ Click Add, and with the left mouse button pressed 
down drag the selector over the desired student icons. 

¶ Right-click a student icon, select Move to Session 
and the letter of the session you want to place the 
student into. 

You can remove students from a session by adding them 
into another one in one of the ways explained above. 
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STUDENT ICONS 

CLASS VIEW 

The Study 700 class view is a graphical layout of your class. 
Your students are displayed as student icons that reflect their 
current status. 

 

The student icons are also color-coded according to the 
session they are in, allowing you to see at a glance, which 
session the students belong to. 

STUDENT ICONS 

 Student name and position 

Student names and student position numbers are indicated 
below each student icon.To edit the name or position of a 
student, right-click the icon, select Edit and either Name or 
Position. 

 Student calling teacher 

A question mark on top of the student icon indicates that the 
student wants to speak with the teacher. To talk with the 
student, click the student icon and select Discuss. If multiple 
students call the teacher, a number will indicate the order of 
the calls. 



18  ¶  Sanako Study 700 v. 8.00 User Guide  

 Message from student 

Messages from students are displayed above the student 
icons 

 Locked student  

A locked student workstation (Lock PC, Lock Screen, or Lock 
Mouse and Keyboard). 

 Student receiving tutor screen 

A student who receives the Tutor screen, when the Tutor 
screen is shared to students. 

 Student receiving model studentôs screen 

A student who receives the Model Student screen, when a 
student screen is shared to others. 

 Model student 

A student whose screen is being shared to other students 
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FUNCTIONS FOR A SINGLE STUDENT 

Clicking a student icon opens a student monitoring window 
with functions that apply to the selected student. 

 

DISCUSS 

Talk with the student. Adjust the student volume with the 
slider during the discussion.  

SHARING TEACHER-STUDENT DISCUSSION  

You may also share a teacher-student discussion with 
others. To do this, first click Talk to address the whole class 
and then select a student and click Discuss.  

SHARE AUDIO 

Share audio will allow you to share the studentôs microphone 
audio or the studentôs discussion group audio to others. The 

audio can be shared to the entire classroom , or 
to the session the teacher currently has selected 

. 

When the student is in a pair or group discussion, share 
audio allows you to share that discussion as a model for 
others. 

PC CONTROL 

PC Control options include shut down functions, locking 
functions, the possibility to launch programs, selecting which 
applications students have access to, disabling Internet use 
and showing or hiding student applications on the student 
computer. 

For information on the different PC Control options, see PC 
control options later in this guide. 
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REMOTE CONTROL 

View and control the selected studentôs screen in the Screen 
Control window. 

For more information on the functions in the Screen Control 
window, see Screen Control window later in this guide. 

HOMEWORK 

Distribute exercise files and material to students. Students 
can then work with the files and hand in their work once they 
are finished.  

For more information on the Homework function, see 
Homework later in this guide. 

MESSAGES 

Opens the message window in which you can send a 
message to the student. 

 

TO SEND A MESSAGE 

1. Type your message in the Message text field. 

2. The current student is selected as the recipient by 
default. 

3. Click Send. The message is now displayed on the 
student screen. 



 

 Study 700 Teacher application  ¶  21 

FUNCTIONS FOR ENTIRE CLASS / A SESSION 

The functions in the function buttons apply either to all 
students or to the currently selected session. 

¶ Clicking the buttons will perform the function for the 
entire class. 

 

¶ Clicking the color-coded icons will perform the 
function for the current session. 

 

TALK 

Talk allows you to talk to students while the student 
microphones are muted. To end the call, simply click the 
Talk button again. 

The Talking to students text above the Function buttons 
indicates when the students can hear you. 

 

Control the 
entire class 
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SHARING TEACHER-STUDENT DISCUSSION  

You may also use the talk function to share a teacher-
student discussion with others. To do this, first click Talk to 
address the whole class and then select a student and click 
Discuss.  

PC CONTROL 

The different PC control options give you full control over the 
shutdown functions of student computers and also allow you 
to launch programs, select which applications students have 
access to, disable Internet use and show or hide student 
applications on student workstations. With the locking 
functions you can ensure that the studentsô full attention 
remains on the task at hand. 

 

SHUT DOWN OPERATIONS 

Selecting Shutdown operations opens a dialog that allows 
you to control the shutdown functions of student computers. 

 

Checking the Allow students to save their open files 
option will let the students save open files before the 
selected shutdown command is performed. 

Shut down ï Shut down student computers 

Log off ï Log off current users on student computers 

Restart ï Reboot student computers 
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SWITCH ON STUDENT PC 

Selecting Switch on Student PC starts up the student 
computers in the group or classroom.  

Note: This function requires that Wake-On-LAN has been 
enabled on the student PC network cards.  

LOCKING OPTIONS 

Lock PC ï Studentsô screens are blacked out and students 
are unable to use neither their keyboard nor mouse. You can 
then launch files or applications on top of the blank screen. 
To unlock the student computers, re-click the option. 

Lock screen ï Studentsô screens are blacked out, but 
students can still use their mouse and keyboard to work with 
anything you launch on their screen. To unlock the student 
computers, re-click the option. 

Lock keyboard and mouse ï Students are able to view 
their own screens, but will not be able to use their keyboard 
or mouse. To unlock the student computers, re-click the 
option. 

Lock Voice Insert ON ï Lock the Voice Insert mode On or 
Off for students. This allows you to make sure that your 
students have the correct recording mode for the lesson. 

LAUNCH PROGRAM 

Selecting Launch program allows you to launch any 
programs on the student computers or in a shared area for 
the students, as well as create shortcuts to programs that are 
frequently used.  

TO LAUNCH A PROGRAM FOR STUDENTS 

 

1. Either type in the name of the program or click 
Browse to browse for it (*.exe files). 
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2. Select whether the program window on student 
screens should be Normal size, Maximized, or 
Minimized to the taskbar. 

3. Click Launch. 

TO CREATE A SHORTCUT 

 

1. Click Browse to browse for a program  

2. Click Save program shortcut to shortcuts list to 
create a shortcut to the selected program. 

3. You can now launch the program to students simply 
by double-clicking the shortcut. To remove a shortcut, 
simply select it and press Delete on your keyboard. 

TO CLOSE A LAUNCHED PROGRAM 

 

1. Select a launched program that you want to close on 
the list. 

2. Select whether you want to allow students to save 
their work before the program is closed. 

3. Click on the Close button to close the selected 
program or click on the Close all button to close all 
launched programs 
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SHOW STUDENT APPLICATION 

Clicking this item will launch student recorders on the student 
screens. 

BLOCK APPLICATIONS 

Blocking applications allows you to select which applications 
students are allowed to access and use.  

  

To allow or prevent applications 

1. Select who you want to prevent or allow applications 
for with the Target drop-down menu. You can use the 
function for all students, a group, or a single student 

 

2. Check the applications that you want to prevent under 
the Prevented applications list or the applications 



26  ¶  Sanako Study 700 v. 8.00 User Guide  

you want to allow under the Allowed applications list 

 

3. Click either Prevent or Allow to activate the 
selections 

¶ Click Prevent to deny the selected applications. 
Students will now be able to use any applications 
except the ones that have been checked.  

¶ Click Allow to allow students to use only the 
selected applications. Students will now be unable 
to access any applications except the ones that 
have been checked. 
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EDITING THE LISTS OF DENIED AND ALLOWED 
APPLICATIONS: 

 

¶ To add a selected application to the denied and 

allowed applications lists, click the  button and 
enter the name of the application.  

¶ To add all the applications currently open on the 

student computers to the lists, click the  button. 

¶ To load the application list from a file, click the  
button for the Denied applications or Allowed 
applications list. 

¶ To save the application list into a file for later use, 

click the  button for the Denied applications or 
Allowed applications list. 

DISABLE INTERNET 

Selecting Disable Internet prevents the students from 
opening and using Web browsers on the student 
workstations. 

SCREEN CONTROL 

The different screen control options allow you to monitor and 
control student screens, as well as to share either the 
teacher screen or a selected studentôs screen to others. 
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AUTOSCAN 

Opens the screen control window and allows you to 
monitor the screen activity of student workstations 
automatically, one after the other. 

 

Select a screen control mode with the buttons on top of the 
screen. 

 

MONITOR 

View the selected student screen and listen to the student. 

AUTOSCAN 

Autoscan automatically changes monitoring from one student 
to the next after a set period of time. 

REMOTE CONTROL 

Control the currently displayed student screen with your 
mouse and keyboard, for example, to help the student with a 
task. The studentôs mouse and keyboard are locked during 
Remote Control. 

COLLABORATE 

Control the currently displayed student screen with your 
mouse and keyboard simultaneously with the student, for 
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example, to instruct the student in the use of an application. 
Both you and the student will move the same mouse pointer. 

NEXT / PREVIOUS STUDENT SCREEN 

 

Use the arrow buttons to change to the next or previous 
student screen. 

THUMBNAILS 

Selecting Thumbnails displays thumbnail images of student 
screens in place of the student icons. 

 

You can adjust the size of the thumbnail images in Tools 
menu > Preferences > Tutor tab. 
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THUMBNAILS IN SEPARATE WINDOW 

Selecting Thumbnails in separate window opens an 
additional window where the student thumbnails are 
displayed.  

TUTOR SCREEN TO STUDENTS 

This allows the teacher to display the teacher screen on the 
student screens while talking to them. During the screen 
sharing, students will see the teacher screen but are not able 
to use their keyboard or mouse to control it. 

ON THE AIR 

When the Tutor screen is shared to students an On The Air 
indication panel appears in the lower-right corner of the tutor 
screen 

 

To end the screen transfer, click on the Stop Transfer 
button in the On The Air panel. 

 

MARKER TOOL 

The marker tool allows instructors to make annotations onto 
the shared tutor screen. To use the Marker Tool, click on the 
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Marker Tool button in the On The Air panel. 

 

This will open a toolbar with different annotation tools into the 
top right corner of the Tutor screen. 

 

 

 

 

 

 

 

 

MODEL SCREEN TO STUDENTS 

This displays a selected studentôs screen to the other 
students and the model student can also talk to the others. 
Instead of teaching all the sessions yourself, you can use 
screen sharing to set one of the students to instruct the 
others or to let a student give a presentation. 

To set a model student, select Model screen to students 
and then click on the desired student. 

HOMEWORK 

The Homework feature allows teachers to distribute material 
to students for independent work. Students are then free to 
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save these files on a USB stick, for example, and work on 
the material at school or at home.  

To open the Homework window where files can be 
distributed to and collected from students, click the 
Homework function button.  

 

This opens the Homework window where you can assign 
homework material to students and collect the studentsô work 
back. 

 

ADDING AND REMOVING HOMEWORK FILES 

When handing out homework material to students, you need 
to first select who you want to give the homework files to with 
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the Target drop-down menu.   

 

The icons above the handout files list allow you to add and 
remove homework files.  

 

 Add a handout file. A window opens automatically 
where you can browse for the file.  

 Remove the selected file form the handout files list 

 Remove all files from the handout files list 

 Preview the selected handout file on the teacher 
computer 

The files that have been added to the homework files by the 
tutor are available in the Student Player Homework file area. 
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COLLECTING HOMEWORK 

The lower part of the Homework window includes the 
functions for collecting homework assignments back from 
students.  

 

SELECTING COLLECTION FOLDER 

Before students can hand in their work, you need to define 
the location where the collected files will be saved. Click 
Browse and select a suitable folder. The folder path is then 
displayed in the homework window. 

 

HANDING IN HOMEWORK FILES 

To allow students to hand in their work, click the Allow 
returning button. This opens a window on student 
computers where students can send their homework files 
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back to the teacher.  

 

At the student end, click Browse and select the file you want 
to hand in. The file is now displayed in the student window 
for returning homework. To send the file to the teacher, click 
Send. The Status column tells the student when the file has 
been delivered. 

 

VIEWING RETURNED FILES 

The teacher can view the returned files, by clicking the Open 
folder now link. If the Open folder when enabled option is 
checked, then the folder where the files are collected to is 
opened automatically when the teacher allows students to 
hand in their work.  
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WEB BROWSER 

The Study 700 Web browser contains all the functions of a 
standard browser, as well as additional features that allow 
you to control studentsô navigation. 

 
The �W�X�W�R�U�¶�V Web browser 

BROWSER CONTROL BUTTONS 

 
Back moves back to the last visited Web page. 

 
Forward moves to the page you viewed before 
clicking the Back button. 

 
Stop stops opening and loading a Web page. 

 
Refresh gets the latest version of a currently 
viewed Web page. If a page cannot be 
displayed, you may try to reload it by clicking 
Refresh. 

 
Home moves to the default home page. 

 

Search launches an Internet search page. 

 
Print prints the current web page. 

 
Send opens student browsers on the Web 
page you currently have open.  

 
Follow makes student browsers follow your 
navigation.  

 
Settings allows you to block pop-up windows 
and to show or hide the toolbar on student 












































































